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AHGW Pro 1.0 Tutorial 

Subsurface Analyst – Creating 2D Cross Sections 
Create 2D cross sections using Arc Hydro Groundwater in ArcGIS Pro  

 
 

Objectives  

Learn how to use Arc Hydro Groundwater Pro tools to create cross sections by combining data from 
different sources. 

 

Prerequisite Tutorials 

 None 

Required Components 

 ArcGIS Pro 

 3D Analyst 

 Subsurface Analyst 

 Groundwater Analyst 

Time 

 40–65 minutes 
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1 Introduction 

Arc Hydro Groundwater Pro (AHGW Pro) is a geodatabase design for representing 
groundwater datasets within ArcGIS Pro. The data model helps to archive, display, and 
analyze multidimensional groundwater data. This includes several components to 
represent different types of datasets such as representations of aquifers, wells, 
boreholes, 3D hydrogeologic models, temporal information, and data from simulation 
models.  

The Arc Hydro Groundwater Pro tools help to import, edit, and manage groundwater data 
stored in an AHGW Pro geodatabase. Subsurface Analyst is a subset of the AHGW Pro 
tools that is used to manage 2D and 3D hydrogeologic data and create subsurface 
models including generation of borehole representations, cross sections, surfaces, and 
volumes. This tutorial will demonstrate how to create cross sections by combining data 
from different sources including geologic maps, surfaces, and borehole stratigraphy. 

Subsurface Analyst includes tools for creating 3D cross sections and volumes from a set 
of surfaces. The workflow and tools for creating 3D features are described in a separate 
tutorial.  

1.1 Background 

Data used in this tutorial are based on data from a study in the city of Woburn conducted 
by the USGS. The data were modified for the purposes of the tutorial. The site location is 
shown in (Figure 1). 
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Figure 1      Location of the Woburn Model 

For the purpose of this tutorial, three primary hydrogeologic units were defined. The base 
of the model domain is deep gravel, the middle part is alluvium consisting of sand and 
silt, and the top unit is a peat layer that is limited to the river area. Figure 2 shows the 
sequence of formations used in the model. Each of the units is indexed by a 
hydrogeologic unit identifier (HGUID), and the unit properties are defined in the 
HydrogeologicUnit table.  

  

Figure 2      Hydrostratigraphic units in the model area 

1.2 Outline 

The objective of this tutorial is to introduce the basic workflow and tools for creating 2D 
cross sections (XS2D). It will cover the following tasks: 

1. Reviewing the structure of the data model classes needed for working with 2D 
cross sections. 

2. Sketching section line features. 

3. Running the XS2D Wizard to set up a new XS2D data frame and corresponding 
feature classes. 

Gravel (HGUID = 3)

Alluvium silt and 

sand (HGUID = 2)

Peat (HGUID = 1)
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4. Creating XS2D Lines representing the intersection of the ground surface DEM 
with a set of outcrop polygons. 

5. Sketching cross section panels in the XS2D data frame in ArcGIS Pro. 

6. Adding an XS2D Line representing the water table to the cross section. 

7. Building 3D GeoSections from the sketched cross section, and visualize the new 
GeoSection features in ArcGIS Pro. 

1.3 Required Modules/Interfaces 

The following components should be enabled in order to complete this tutorial: 

 ArcGIS Pro license 

 3D Analyst 

 Arc Hydro Groundwater Pro Tools 

 Arc Hydro Groundwater Pro Tutorial Files 

The AHGW Pro Tools require that there is a compatible ArcGIS Pro service pack 
installed. Check the AHGW Pro Tools documentation to find the appropriate service pack 
for your version of the tools. 3D Analyst is required for the last section of the tutorial for 
visualizing 3D features. If 3D Analyst is not available, skip these parts of the tutorial. The 
tutorial files should be downloaded and saved on a local drive. 

2 Getting Started 

Begin by opening a project containing some background data for the Woburn project.. 

1. If necessary, launch ArcGIS Pro. 

2. If on the ArcGIS Pro start page, select  Open another project in the bottom 
right corner of the window to open the Open Project dialog. 

3. If already in the user interface, use the  Open macro to open the Open Project 
dialog. 

4.  Browse to the location with tutorial files for this tutorial. 

5. Select the file “xs2d.aprx” located in the SubsurfaceAnalystPro/XS2D folder. 

6. Click OK to import the project. 

Once the file has loaded, a map of the model area will appear (Figure 3). The map 
includes a boundary of the model domain, polygons representing outcrops, and wells 
within the model domain that have related borehole stratigraphy. A Digital Elevation 
Model (DEM) raster representing the land surface elevation over the model domain and a 
raster representing the water table surface are also available.  
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Figure 3      Model domain 

Before continuing, ensure that the AHGW Pro tools are correctly configured. 

1. In the Catalog pane, expand the  Toolboxes folder. 

The ArcHydroGroundwater.pyt toolbox should appear under the list of toolboxes. If 
toolbox is not visible, complete the following:  

2. In the Catalog pane, right-click on  Toolboxes and use the  Add Toolbox 
command to open the Add Toolbox dialog. 

3. Browse to the location of  C:\Program Files\Aquaveo\ 
AHGW_ArcGIS_Pro_Python_Toolbox directory and select and open the 
ArcHydroGroundwater.pyt file. 

4. Click OK to close the Add Toolbox dialog. 

With the ArcHydroGroundwater.pyt toolbox available, access the Groundwater Analyst 
tool. 

5. Expand “  ArcHydroGroundwater.pyt”. 

When using geoprocessing tools, it’s possible to set the tools to overwrite outputs by 
default, and automatically add results to the map/scene. To set these options: 

6. At the top of the ArcGIS Pro window, select the Project tab. From the list on the 
left, select Options to open the Options dialog. 

7. Select Geoprocessing from the list under Application on the left of the dialog. 

8. Ensure that Allow geoprocessing tools to overwrite existing datasets and Add 
output datasets to an open map are turned on. 

9. Select OK to exit the Options dialog. 

10. Using the arrow in the upper left corner, return to the main screen. 

3 Representing 2D Cross Sections in the AHGW Pro Data Model 

Before starting to create cross sections, it is helpful to review the component of the 
AHGW Pro Data Model we will be using. The AHGW Pro Data Model includes a number 
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of components used for different purposes. The Hydrostratigraphy component includes 
data structures for representing 2D and 3D hydrostratigraphy, including the creation of 
2D cross sections (Figure 4).  

SectionLine is the central feature class used to manage cross sections. Each SectionLine 
represents a cross section in map view. SectionLine features are indexed with a HydroID, 
which uniquely identifies them within the geodatabase. To create a vertical (profile) view 
of the cross section along the SectionLine, each SectionLine feature is associated with 
multiple feature classes representing the two-dimensional cross section, and these are 
given the “XS2D” prefix.  

Common XS2D feature classes are: 

 XS2D_Panel – polygon features representing cross section “panels”. 

 XS2D_BoreLine – vertical lines representing hydrostratigraphy along selected 
boreholes adjacent to the SectionLine. 

 XS2D_PanelDivider – vertical guides showing the location where a SectionLine 
changes direction. 

 XS2D_MajorGrid and XS2D_MinorGrid – grid lines showing the vertical and 
horizontal scales in an XS2D data frame. 

Additional feature classes can be added to represent items such as land surface 
elevation, water table, faults, etc.  

 

Figure 4      Datasets used for creating 2D cross sections 

Each of the 2D cross sections is generated in a separate data frame in ArcGIS Pro. The 
XS2D feature classes are created in an {S, Z} coordinate system that is unique for each 



AHGW Pro Tutorials  Subsurface Analyst – Creating 2D Cross Sections 

 Page 7 of 24 © Aquaveo 2023 

cross section. The S coordinate represents the length along the SectionLine (equivalent 
to the x-direction in the XS2D data frame) and the Z coordinate represents the vertical 
dimension (the y-direction in the XS2D data frame). In addition, XS2D features can be 
scaled (exaggerated) in the Z dimension for better visualization. Subsurface Analyst 
includes a number of tools for transforming features between a “real” coordinate system 
(X, Y, and Z) and a 2D coordinate system (S, Z), and for scaling features. 

The XS2D_Catalog table is used for managing XS2D feature classes. The Catalog lists 
the XS2D feature classes related with each SectionLine feature. The SectionID field in 
the XS2D_Catalog references a HydroID of a SectionLine feature, thus creating a 
relationship between SectionLines (defined in real world coordinates) and XS2D feature 
classes. An example of a typical XS2D_Catalog table is shown in Figure 5. Notice that all 
feature classes in the catalog end with a number (in this example 1) that references the 
HydroID of the related section line. 

 

Figure 5      Example XS2D_Catalog used for managing XS2D feature classes and establishing a 
relationship between the XS2D features and a SectionLine feature 

4 Sketching SectionLine features 

The first step will be to create a set of section line features from which the 3D features 
will be derived. The section line features will be drawn on the model map. The map 
includes a boundary defining the extent of the 3D model, well features, and outcrops as 
shown in Figure 6. 

 

Figure 6      Map containing the model boundary, wells, and outcrops 
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To start sketching section lines: 

1. On the ribbon, select the Edit tab. 

2. Select the Edit   button to start editing. 

3. Select the Create  button. 

4. In the Create Features pane select the “   SectionLine” item. This will enable 
editing of section lines. 

5. Select the Line  tool from the Editor Toolbar. 

6. Sketch two section lines covering the model domain, as shown in Figure 7 
starting with the sketch line labeled “A-A’”. Make sure that the section lines do 
not extend beyond the model domain. 

Tip: The direction of digitization defines the orientation of the cross section data. The 0 
grid line (representing the beginning of the section line) will be on the left side of the data 
frame. For section lines going east-west, start the sketch on the west side and sketch to 
the east side. This will ensure that the cross section and map data are visually 
compatible.  

7. Right-click on “SectionLine” in the Contents pane and select Attribute Table to 
bring up a SectionLine table pane. 

8. In the SName attribute, enter “A-A’” for the first sketched section lines and “B-B’” 
to the second sketched lines.  

At this point the map should be similar to the one shown in Figure 7. 

 

Figure 7      Section lines sketched within the model boundary 

Next, assign vertical exaggeration values to the section lines. The cross section features 
will be scaled based on the vertical exaggeration attribute. 

9. In the SectionLine table, click Clear  to clear the selection. 
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10. Right-click on the Vertical Exaggeration field and select Calculate Field to open 
the Calculate Field dialog.  

11. In the VertExag2D= field, enter “20” for the vertical exaggeration value. 

12. Click Apply, then OK to exit the Calculate Field dialog. 

13. Close the SectionLine table. 

14. Select Save Edits in the Manage Edits section of the Edit tab. 

15. If a dialog appears asking to confirm the save, click Yes. 

16. Select Edit in the Manage Edits section of the Edit tab to stop editing. 

After creating the features, HydroID values need to be assigned to them. The HydroID is 
the unique identifier of the feature within the geodatabase, and is used to create 
relationships between tables and feature classes. There are tools to help you manage 
your HydroIDs. The tool uses a UniqueID table to track the addition of HydroIDs in the 
geodatabase (The table has already been created using the Create Unique ID Table tool 
available in the Groundwater analyst toolset). 

17. In the Catalog pane, expand “  ArcHydroGroundwater.pyt”. 

18. Expand “  Groundwater Analyst”. 

19. Double-click “  Assign HydroID GW” to open the Assign HydroID GW pane. 

20. Set Input UniqueID Table to “UNIQEID”. 

21. Set Input Features to Assign HydroID to “SectionLine”. 

22. Set HydroID Field of Input Features to “HydroID”. 

23. Select Run to execute the tool. 

If desired, open the attribute table of the SectionLine layer to see that HydroIDs were 
assigned to the features. 

5 Using the Create XS2D Cross Section Tool 

The Create XS2D Cross Section tool creates a new set of feature classes for 
representing a 2D cross section based on a specific SectionLine feature. The wizard 
creates a new data frame to which the XS2D feature classes (XS2D_Panel, 
XS2D_BoreLine, XS2D_PanelDivider, XS2D_MajorGrid, and XS2D_MinorGrid) are 
added. Using a separate data frame for each 2D cross section allows us to visualize the 
features from each cross section independently. 

Before actually running the Create XS2D Cross Section tool, select a set of wells to be 
included in the process of creating a 2D cross section. Borehole data related to these 
wells will help guide the cross section dimensions and borehole stratigraphy will be 
added to the cross section.  

1. Select the Map tab in the ribbon. 

2. Select SectionLine A-A’ using the Select Features  tool.  

3. Select Select By Location  to open the Select By Location dialog. 

4. In the Input Features section, select the “Well” item. 

5. In the Relationship section, select the “Within a distance” item. 

6. In the Selecting features section, select the “SectionLine” item. 
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7. Set the Search Distance to “200” feet. 

8. Click Apply and review the selected wells. Note that it might be necessary to 
modify the buffer distance depending on how the section line is sketched to 
select 5–6 wells.  

9. Click OK to close the Select by Location dialog. 

After applying the selection you should have six wells selected in the map as shown in 
Figure 8.  

 

Figure 8      Selected features after applying the Select By Location with a buffer of 200 feet 

Next, run the Create XS2D Cross Section tool to create a new cross section. The Create 
XS2D Cross Section tool is based on a selected section line and the wizard runs one 
cross section at a time. To start the Create XS2D Cross Section tool: 

10. Select the Arc Hydro Groundwater tab on the ribbon. 

11. Select the Create 2D Cross Section  to open the Create XS2D Cross Section 
pane. 

The Create XS2D Cross Section tool will create a set of feature classes and a new data 
frame for the selected SectionLine.  

The tool is used to set up the appropriate panel, boreline, and panel divider feature 
classes. It can also specify the elevations for drawing panel dividers. Default values, 
based on the borehole data, are set for the minimum and maximum elevations of the 
panel dividers. The default values can be kept or modified.  

12. In the SectionLine Layer section, select “SectionLine”. 

13. In the Wells and Borehole Log section, turn on Use well and borehole log data.  

14. Fill out the Wells and Borehole Log sections as follows: 
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 Well Layer set to “Well”. 

 Well Unique ID Field set to “HydroID”. 

 Boreholelog Table set to “BoreholeLog”. 

 WellID field set “WellID”. 

15. Click the Select tool located in the SectionLine Layer section to fill in the ID, 
Length, and Name options.  

The tool is also used to create major and minor grid lines. The grid extent and spacing 
can be automatically specified based on the length of the selected SectionLine and 
borehole data, or they can be set manually. 

16. In the Panel Divider Elevation section, click Suggest Values from Well Data. 

17. In the Grid Extent section, click Suggest Grid Extent. 

18. In the Grid Spacing section, click Suggest Grid Spacing. 

At this point the inputs should be similar to the ones shown in Figure 9. 

19. Select Create XS2D Data to run the tool. 
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Figure 9      Settings for the Create XS2D Cross Section tool 
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A new Data Frame (Section A-A’) should be added to the map (be sure to be in layout 
view to be able to view both data frames). Notice the grid lines, the panel dividers, and 
the boreline features. Boreline features are automatically symbolized by the HGUID to 
differentiate between the hydrogeologic units. In addition, the borelines are symbolized 
by the Offset field such that borelines from wells closer to the cross section are wider. 
Also, notice that grid lines showing the vertical and horizontal dimensions were added to 
the data frame. 

Resize the A-A’ data frame and move it within the map layout such in order to see both 
data frames. To better view the XS2D feature created: 

 Using Explore  tool, move the Section A-A’ data frame within the map layout 
and resize it. 

 Use the zoom tools ( ) to focus on the data within the cross 
section. 

Use the HGU Color Manager to manage colors within the cross section data frames: 

20. In the Contents pane, switch to List By Data Source . 

Now to load the hydrogeologic unit table to the A-A’ data frame. 

21. Select Add Data  to open the Add Data dialog. 

22. Browse to and open the “Woburn.gdb” geodatabase. 

23. Select the “HydrogeologicUnit” file and click OK to import the table and close the 
Add Data dialog. 

24. Select the Arc Hydro Groundwater tab in the toolbar. 

25. Select the HGU Color Manager  macro to open the HGU Color Manager 
pane. 

26. Change the settings to be as follows: 

 HGU Table to “HydrogeologicUnit”. 

 HGU ID Field to “HydroID”. 

 HGU Name Field to “HGUName”.  

If desired, modify the colors by using the color picker buttons in the Symbology column to 
pick a color for each of the HGUID values (listed in the HGU ID column). 

27. Click Apply Symbology to apply the changes. 

Note that the selected color scheme has been applied to all of the selected scene layers. 

Increase the width of the XS2D_BoreLine features by:  

28. Right-click on the “XS2D_BoreLine_1” layer and select Symbology to open the 
Symbology pane. 

29. Select the Class tab and open the More drop-down menu to select the Format 
All Symbols to go to the Format Multiple Line Symbols dialog. 

30. Select the Properties tab and adjust the symbol Line Width to a value of “5.0”. 

31. Click Apply. 

At the end of this process, there should be an XS2D data frame that is similar to the one 
shown in Figure 10. 
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Figure 10      Initial XS2D data frame with XS2D features created by the Create XS2D Cross 
Section tool 

Before continuing, create an additional cross section data frame for section line B-B’.  

32. Repeat steps 1–31 to create an additional XS2D data frame for section B-B’. 
Note that the buffer distance may need to be changed to enable the selection of 
4–5 wells adjacent to section line B-B’. 

If desired, add text boxes to define sections A-A’ and B-B’ within the map layout. At the 
end of this process the map layout should be similar to the one shown in Figure 11. 
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Figure 11      Map layout containing cross sections A-A’ and B-B’ 

This is a good starting point for digitizing cross sections by connecting borehole data. But 
before sketching cross sections, add additional data that will guide the process for 
creating cross sections.  

6 Adding Data from Geologic Maps 

An important source of data to use while sketching cross sections is outcrop information 
from geologic maps. Geologic maps describe the outcropping of rock units (the coverage 
of a rock unit over the land surface). When combined with a digital elevation model, the 
geologic map data provides additional information to include in a cross section. The map 
includes a set of polygon features that represent outcrops of the peat and alluvium 
formations defined within the model.  

Before continuing, create a new line feature class to which the output XS2D Lines will be 
written. 

1. Switch to the “  Map” view. 

2. Select the Map tab on the ribbon. 

3. In the Selection section, click the Clear  macro.    

4. In the Catalog pane, expand the “  Subsurface Analyst/XS2D Editor” toolset 

under the “  ArcHydroGroundwater.pyt” toolset. 

5. Double-click on the “  Create XS2D Line Feature Class” tool to open the Create 
XS2D Line Feature Class pane. 

This tool will create a new XS2D line feature class for each of the selected SectionLine 
features. If no section line is selected it will create feature classes for all section lines in 
the SectionLine feature class. 

6. For Input Section Line Features select “SectionLine”. 

7. For XS2D_Catalog Table select “XS2S_Catalog”. 

8. For XS2DType value of the XS2D line feature enter “Outcrop”. 

9. For Feature Class Name Prefix enter “Outcrop”. 

The feature classes created will include the prefix specified and the HydroID of the 
section line feature (e.g. Outcrop_1).  

10. Click Run to execute the Create XS2D Line Feature Class tool. 

Two new feature classes named “Outcrop_1” and “Outcrop_2” should be added to the 
Contents pane.  

Next, add XS2DLine features to the feature class just created. Each line in the feature 
class represents the intersection of the section line with a surface (raster). The values 
from the raster are usually scaled in the Z dimension, so they can be better visualized.  

To add geologic map data along the cross sections: 

11. In the Catalog pane, expand the “  Subsurface Analyst/XS2D Editor” toolset, 

double-click on “   Transform Polygons to XS2D Lines” tool to open the 
Transform Polygons to XS2D Lines pane. 

12. For Input Polygon Features select “Outcrops”. 

13. For Input Section Line Features select “SectionLine”. 
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14. For Input XS2D_Catalog Table select “XS2D_Catalog”. 

15. For XS2DType select “Outcrop”. 

16. For Ground Surface DEM select “dem100ft”. 

The Discretization Spacing should be automatically populated after selecting the raster. 
The default spacing is equal to the raster cell size. 

17. Specify a Discretization Spacing of “100”. 

18. For FType value of the features to create enter “Outcrop”. This is an optional 
value that enables classifying the XS2DLine feature created. 

The Overwrite parameter should be enabled automatically, such that before writing new 
features, the tool clears the target feature class. If it is disabled, then new features will be 
appended to the feature class. 

19. Click Run to execute the Transform Polygons to XS2D Lines tool. 

When the tool is done a new set of lines is added to the Outcrop_1 and Outcrop_2 
feature classes. To view the lines within the cross section data frames:  

20. Switch to the “  Section A-A’” map view. 

21. In the Catalog pane, expand the “  woburn.gdb” item under the “   
Databases” item. 

22. Expand the “   Data” item, then right-click on the item and select Refresh. 

23. Drag the “  Outcrop 1” item into the “  Section A-A’” map view. 

Next, use the HGU Color Manager to modify the symbology of the outcrop lines: 

24. Select the Arc Hydro Groundwater tab in the toolbar. 

25. Select the HGU Color Manager  macro to open the HGU Color Manager 
pane. 

26. Click Apply Symbology to apply the changes. 

Note that the selected color scheme has been applied to the outcrop lines. 

27. Repeat steps 20–26 for the B-B’ cross section data frame. 

At this point the XS2D data frames (A-A’ and B-B’) should be similar to the one shown in 
Figure 12. 

 

Figure 12      Cross section data frames with borelines and outcrops 

The borelines and outcrops will be used while digitizing new cross sections. 
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7 Sketching Cross Section Panels 

In this section, new cross section panels will be sketched. Use the boreline data and 
outcrops as guides while utilizing the advanced editing capabilities available in ArcGIS 
Pro.   

7.1 Creating a New Template for Editing XS2D Panel Features 

First create a template for the XS2D Panel feature class: 

1. Switch to the “  Section A-A’” map view. 

2. In the Contents pane, select “XS2D_Panel_1” then right-click and select 
Symbology to open the Symbology pane. 

Before creating a template, make sure that the symbology of the panels is setup 
correctly. The XS2D_Panel symbology should have already been set using the HGU 
Color Manager in previous steps of this tutorial. The symbology of the XS2D_Panel layer 
should be similar to the one shown in Figure 13. If the symbology is not set correctly, set 
it using the HGU Color Manager as shown in section 5. 

 

Figure 13      Symbology for the XS2D_Panel layer 

Next, define a new feature template: 

3. Select Edit tab in the ribbon. 

4. In the Features group, click the Create  button to open the Create Features 
pane.  

The Create Features window should include a template for the XS2D_Panel_1 layer, as 
shown in Figure 14. 
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Figure 14      The Create Features pane after adding a template for XS2D Panel features  

Next, set the snapping environment. 

7.2 Setting the Snapping Environment Options 

Make sure the Section A-A’ map view is still activated and the Create Features pane is 
open. 

For this tutorial activate the snapping option. To enable this option: 

1. In the Snapping section of the Edit tab on the ribbon, select the down arrow 
under Snapping to open up a menu. 

2. Select the Snapping  icon to turn snapping on if it is not on already. 

7.3 Sketching Panels 

1. Zoom to the right end of the cross section and zoom in on the outcrop 
representing HGUID = 2 (Alluvium). 

2. In the Create Features pane, under “XS2D_Panel_1”, select the feature 
symbology for HGUID = 2.  

Notice that the Construction Tools window contains a list of the available tools for 
creating new panels. 

3. Make sure the Polygon  tool is selected.   

The Trace editing tool will be used to trace the outcrop as part of the cross section 
creation. 

Tip: while sketching, use the zoom and pan tools to focus on certain elements of the 
cross section.  

4. In the Editor pane, select the Trace  tool. 

5. Trace the outcrop defining HGUID = 2. Start tracing from the right side by clicking 
on the edge of the line, then drag the mouse over the outcrop line. A new line 
should appear while moving the mouse to the left side of the outcrop. When the 
end of the outcrop line is reached, click on the edge to create a vertex.  

The sketch should be similar to the one shown in Step 1 of Figure 15. 

6. Using the Line  tool, and continue sketching a cross section panel. Use the 
boreline edges as a guiding point. The sketch tool should automatically snap to 
the end of the boreline features while digitizing. Make sure to also snap to the 
panel dividers defining the start and end of the cross section.  
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7. Change between the Line  and Trace  tools to follow the borelines and 
outcrops. 

The sketch should be similar to the one shown in Step 2 of Figure 15. 

8. Make sure to reach the right side panel divider as shown in Step 3 of Figure 15. 

9. Double-click on the starting point to close the panel. 

The sketch should be similar to the one shown in Step 4 of Figure 15.  

Tip: To better visualize the borelines on top of the panels, set a transparency of 70% on 
the panel features (select the layer, right-click, and select Display tab to set the 
transparency for the layer). 

Next, assign some basic attributes to the panel. 

 

Figure 15      Steps in sketching a cross section panel 

 

10. Using the Select  tool, select the feature which was just created.  

11. Right-click and select Attributes to open the Attributes pane. 

In the Attributes pane make sure a value of “2” is in the HGUID field so it matches the 
HGUID of the borelines and outcrops used in the sketching process. This value should be 
created automatically. 

12. In the Edit tab of the ribbon, select Save Edits . 

Next, digitize the panel for the peat layer represented by HGUID = 1: 

13. Zoom in to the outcrop line representing HGUID = 1.  

14. In the Create Features pane, under “XS2D_Panel_1”, select the feature 
symbology for HGUID = 1.  

15. Select the Autocomplete Polygon  tool. 

Step 1: Use the trace tool to 
trace the outcrop line

Step 2: Sketch the cross section panel 
by connecting the borelines and 
tracing over the outcrop

Step 3: Make sure to reach the 
panel dividers on the left and 
right edges of the cross section

Step 4: Finish the sketch
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16. Using the Trace  tool, sketch a line following the outcrop representing HGUID 
= 1. 

17. Make sure that the line snaps to the end of the panel representing unit 2, as 
shown in Figure 16. 

 

Figure 16      The new polygon should snap to the vertex located at the intersection of the cross 
section panel and outcrop 

18. Double-click on the starting point to close the panel.  

A new polygon representing HGUID = 1 should be created. The polygon’s boundary 
should match the boundary of the polygon representing HGUID = 2.  

The sketch should be similar to the one shown in Figure 17.  

 

Figure 17      Cross section panel created using the Autocomplete Polygon task 

19. Using the Select   tool, select the feature which was just created.  

20. Right-click and select Attributes to open the Attributes pane. 

In the Attributes pane edit make sure HGUID is set to “1”, so it matches the HGUID of the 
borelines and outcrops used in the sketching process. 

21. In the Edit tab of the ribbon, select Save Edits . 

Next, sketch the panel for the gravel unit HGUID = 3. 
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22. In the Create Features pane, under “XS2D_Panel_1 template”, select the feature 
symbology for HGUID = 3.  

23. Select the Autocomplete Polygon  tool. 

24. Using the Trace  tool, start sketching from the upper left or right corner of the 
unit and make sure to snap to the panel representing unit 2, as shown in Figure 
18. 

25. Using the Line  tool, sketch downward along the panel divider, and then 
across following the borelines representing the bottom of unit 3. At the edge of 
the cross section, snap to the panel dividers and sketch upwards. Make sure to 
snap to the panel representing unit 2, as shown in Figure 18. 

26. Double-click on the starting point to close the panel. 

 

Figure 18      Sketching cross section panel for HGUID = 3 

After finishing the sketch of the gravel unit the cross section should be similar to the one 
shown in Figure 19.  

 

Figure 19      Cross section after sketching the panel representing the gravel unit 

Next, assign some basic attributes to the panel. 

27. Using the Select   tool, select the feature which was just created.  

28. Right-click and select Attributes to open the Attributes pane. 

In the Attributes pane make sure HGUID is set to  “3” so it matches the HGUID of the 
borelines and outcrops used in the sketching process. 
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29. When done editing the attributes, close the Attributes window 

30. In the Edit tab of the ribbon, select Save Edits . 

31. Select Disable Editing . 

32. Repeat steps 1–31 to sketch cross section panels for cross section B-B’ (make 
sure to activate the B-B’ data frame before you start a new edit session). 

At the end of this process there should be two completed cross sections, similar to the 
ones shown in Figure 20. 

 

Figure 20      Completed cross sections with borelines, outcrops, and panels 

Next, add data from a water level raster into the cross section.  

8 Adding Raster Data to the Cross Section 

In this section, add a line representing a water table to the cross section. The line is 
derived from a raster representing the water table surface, values from the raster are 
transformed into the XS2D coordinate system and a new line is created in the cross 
section. 

1. Switch to the “  Map” view.  

2. Click the Clear  icon to unselect all features in the data frame. 

3. In the Catalog pane, expand the “  Subsurface Analyst/XS2D Editor” toolset 

under the “  ArcHydroGroundwater.pyt” toolset.  

4. Double-click on the “  Create XS2D Line Feature Class” tool to open the Create 
XS2D Line Feature Class pane. 

5. For Input Section Line Features select “SectionLine”. 

6. For Input XS2D_Catalog Table select “XS2D_Catalog”. 

7. For XS2DType Value enter “Water Table”. 

8. For Feature Class Name Prefix enter “WaterTable”. 

9. Select Run to execute the tool. 

Two new feature classes WaterTable_1 and WaterTable_2 should be created and added 
to the map. Now create new line features representing the water table along the section 
line. 
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10. In the Catalog pane, expand the “  Subsurface Analyst/XS2D Editor” toolset, 

double-click on “   Transform Raster to XS2D Lines” tool to open the Transform 
Raster to XS2D Lines pane. 

11. For Input Section Line Features select “SectionLine”. 

12. For Input Raster select “watertable”. 

13. For Input XS2D_Catalog Table select “XS2D_Catalog”. 

14. For XS2DType value select “Water Table”.  

15. The Discretization Spacing should be automatically updated to “50”. 

16. For FType enter “water table”. 

17. The Append to Existing XS2D_Line Features option should be enabled to 
append the new feature to existing features. 

18. Select Run to execute the tool. 

19. To view the water table lines on the cross sections, drag the WaterTable_1 and 
WaterTable_2 layers from the Contents and and drop them into the appropriate 
data frames (A-A’ and B-B’). 

20. If desired, adjust the symbol properties of the water table layers in the A-A’ and 
B-B’ cross section data frames. 

At the end of this process a line representing the water table should be added to the 
cross sections, similar to the blue lines shown in Figure 21.  

 

Figure 21      Water table lines added to the cross sections 

9 Transforming 2D Cross Section to 3D GeoSections 

Once the2D cross sections are created, it is possible to transform them to 3D features 
(GeoSections) and visualize them in Scene view. This part of the tutorial requires 3D 
Analyst. 

First, create the GeoSection feature class: 

1. Switch to the “  Map” view. 

2. In the Catalog pane, expand the “  Subsurface Analyst/Features” toolset, 

double-click on “   Create GeoSection Feature Class” tool to open the Create 
GeoSection Feature Class pane. 
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3. In the Output GeoSection Features field, click the browse  button to open the 
Output GeoSection Features dialog.  

4. Browse to the woburn.gdb\Data directory and enter “GeoSection” as the feature 
class name. 

5. Click Save to close the Output GeoSection Features dialog. 

6. Select Run to execute the tool. 

Next, create the GeoSection features by transforming 2D cross section panel polygons to 
3D GeoSections: 

1. In the Catalog pane, expand the “  Subsurface Analyst/XS2D Editor” toolset 

then double-click on “   Transform XS2D Panel to GeoSection” tool to open the 
Transform XS2D Panel to GeoSection pane. 

2. For Input SectionLine Features, select “SectionLine”. 

3. For Input XS2D_Catalog Table select “XS2D_Catalog”. 

4. For Input GeoSection Features, select “GeoSection”. 

5. Select Run to execute the tool. 

Now to visualize the 3D GeoSections just created. 

6. Switch to the “  Scene” map view.  

A 3D scene that includes the DEM and water table rasters rendered as 3D surfaces 
should appear. 

7. Select Add Data  to open the Add Data dialog. 

8. Browse to and open the “Woburn.gdb” geodatabase and open the “Data” 
directory. 

9. Select the “GeoSection” file and click OK to import the table and close the Add 
Data dialog. 

10. If desired, symbolize the GeoSection layer using the HGU Color Manager.  

10 Conclusion 

This concludes the tutorial. Here are some of the key concepts in this tutorial: 

 The Arc Hydro Groundwater data model includes XS2D feature classes that 
provide the framework for working with 2D cross sections in ArcGIS Pro. 

 Sketch cross section lines and use the XS2D Wizard to set up a new data frame 
and create the basic XS2D feature classes. 

 Data from geologic maps in combination with digital elevation models can be 
transformed to the XS2D data frame, and are used as guides for “sketching” 
cross sections.  

 ArcGIS Pro  editing tools are used to help digitize cross sections based on 
guiding features (e.g. borelines, outcrop lines). 

 Additional data can be transformed to the XS2D data frame and added to the 
cross section. 

 2D cross sections can be transformed to 3D features and visualized in ArcGIS 
Pro. 


